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1 Introduction 
 

1.1 What is Smart Design®? 
 

This Smart Design allows you to design and print the images, photos, texts and barcodes on the 

plastic cards (ISO CR-80) or encode on the magnetic stripe. 

When you run Smart Design, you can see a blank screen. This is the 54mm x 86mm card size, the 

same as ISO CR-80. 

 
<Figure 1> The first screen of Smart Design 

 

1.2 System Requirements 
This Smart Design is provided with Smart ID Card Printer. This can be used only with Smart ID Card 

Printer supplied by IDP Corp., Ltd. To operate this program, IDP Card Printer driver should be 

installed. 

For the stable operation, Windows 2000/XP/VISTA and 7, Pentium 1GHz with 256MB of RAM or 

higher, 100 MB free hard disk space or higher systems are recommended. 

 

1.3 Copyright 
This program is not for sale. It is only for the customers of Smart ID Card Printer. No part of this 

program may be reproduced and reused by any way without the permission or the prior written 

agreement of IDP Corp., Ltd. We have no liability for any problem through the dissemination. IDP 

Corp,. Ltd. All rights reserved. 
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2 Program start 
 
2.1 Execute Program 
 

2.1.1  From Window’s “Start” menu 
Click Start menu > All Programs > Smart > SmartDesign 

 

2.1.2  From the shortcut icon created on Desktop background  

 
 

 

2.2 Open the card design file 
 

2.2.1 Using “Open” command in Home tab 
Click Open in Home tab and open the design file(*.csd). 

 
2.2.2 Using “Open” command in File tab 

Click File tab, click Open and  

open the design file(*.csd). 

 

2.2.3 Using “Shortcut key” 
Press Ctrl+O to open. 

 

2.2.4 Using “Recent File” 
Click File tab, click recent File.  

You can open the design file from the list. 

    
(a) Using icon in Ribbon Bar      (b) File open dialog      (c) Using Recent File 

<Figure 2> File Open 
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2.3 Save the card design file 
 

2.3.1 Using “Save” command in Home tab 
Click Save in Home tab 
 

2.3.2 Using “Save” command in File tab 
Click File tab and click Save 

 
2.3.3 Using “Shortcut key” 

Press Ctrl+S to save. 

 

     
(a) Using Save icon in Ribbon Bar  (b) File Save Dialog 

<Figure 3> File Save 

 

2.4 Quit Smart Design 
Click File tab, click Exit or click the “Exit” icon on right top of the program. 

 

 

3 Screen Components 
When you run Smart Design, you can see the program as below. 

 
3.1 Ribbon bar 

Ribbon bar consists of 7 tabs. 

 

3.1.1 Home tab 

 

 

3.1.1.1 Save 

 Save the design file. File format is .csd. 
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3.1.1.2 New 

 Make a new card design. 

 

3.1.1.3 Open 

 Open the design file. 

 

3.1.1.4 Print 

 Print the design file. 

 

<Figure 4> Printer Select Dialog 

Be cautious that it can be printed with only “IDP SMART-50 Card Printer”, so select a 

correct printer name. If you click the properties, the detail setting dialog box will be 

displayed.  

 
<Figure 5> SMART-50 Printer Document Properties 

Even though the layout direction’s setting is wrong, it is adjusted automatically to the 

designed direction. Click OK to save and exit from the detail setting dialog box. Click OK 

to print. 
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3.1.1.5 Font & Barcode list 

  Select the font type or the barcode type. 

You can see all possible font types in Windows or all barcode lists supported in this 

program. 

 

3.1.1.6 Font Size 

 Set the font size of text object or barcode object. 

 

3.1.1.7 Bold 

 Make a bold font. It is activated when the text object is selected. Click the icon or 

press “Ctrl” key with “B” key to make font bold. 

 

3.1.1.8 Italic 

 Make an italic font. It is activated when the text object is selected. To make an 

italic effect, click the icon or press “Ctrl” with “I” key. 

 

3.1.1.9 Underline 

 Underline a font. It is activated when the text object is selected. To make an 

underline effect, click the icon or press “Ctrl” with “U” key. 

 

3.1.1.10 Font Color 

 Set the font color of the text object or the barcode color of the barcode object. 

If click the left side of icon, the color is applied. If press the right downside arrow, you 

can see the color table as below. You can select the desired color to apply to the text 

object or barcode object. 

 
<Figure 6> Color Picker Popup 

To apply other color which is not shown in color table, click “Other color”. 
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<Figure 7> Select Other Color 

Select the specific color you want and click “OK” to apply. The icon’s color will be 

changed. 

 
 

3.1.1.11 Align Left 

 Text is aligned on the left side. 

 

3.1.1.12 Align Center 

 Text is aligned on the center. 

 

3.1.1.13 Align Right 

 Text is aligned on the right side. 

 

3.1.1.14 Justify 

 Text is aligned on the same distance between the characters. 

 

3.1.1.15 Align Top 

 Text is aligned on the top side. 

 

3.1.1.16 Align Middle 

 Text is aligned on the middle. 
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3.1.1.17 Align Bottom 

 Text is aligned on the bottom side. 

 

3.1.1.18 Rectangle 

 Draw a rectangle. If you select this icon, the cursor will be changed to  shape. 

The object is set as color panel. 

 

3.1.1.19 Rounded Rectangle 

 Draw a rounded rectangle. If you select this icon, the cursor will be changed to  

shape. The object is set as color panel. 

 

3.1.1.20 Ellipse 

 Draw an oval. If you select this icon, the cursor will be changed to  shape. The 

object is set as color panel. 

 

3.1.1.21 Line 

 Draw a straight line. If you select this icon, the cursor will be changed to  

shape. The object is set as color panel. 

 

3.1.1.22 Text 

 Make a text box. Input text when text input dialog box is open. The object is set 

as black panel. 

 

3.1.1.23 Image 

 Insert an image. Select the image when the image selecting dialog box is open. 

The object is set as color panel. 

 

3.1.1.24 1D Barcode 

 Make a barcode. Input data when data input dialog box is open. The object is set 

as black panel. You can change the data using “Revise” as below after click the right 

button of the mouse. 
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<Figure 8> Revise Data 

 

3.1.1.25 2D Barcode 

 Make a 2D barcode. The method of data input is same as barcode. 

 

3.1.1.26 Align 

 Click the Align button, popup menu is displayed as below. 

 
<Figure 9> Align Popup Menu 

 

3.1.1.27 Align - Move to Top 

 Move the selected object to top. 

 

<Figure 10> Move the selected object to top 
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3.1.1.28 Align - Move to Front 

 Move the selected object to one step up. 

 

<Figure 11> Move the selected object to one step up 

 

3.1.1.29 Align - Move to Back 

 Move the selected object to one step down. 

 

<Figure 12> Move the selected object to one step down 

 

3.1.1.30 Align - Move to Bottom 

 Move the selected object to bottom. 

 

<Figure 13> Move the selected object to bottom 

 

3.1.1.31 Align – Align - Left Align 

 Align the selected objects to the left of standard object. 

 

3.1.1.32 Align – Align - Right Align 

 Align the selected objects to the right of standard object. 
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3.1.1.33 Align – Align - Top Align 

 Align the selected objects to the top of standard object. 

 

3.1.1.34 Align – Align - Bottom Align 

 Align the selected objects to the bottom of standard object. 

 

3.1.1.35 Align – Align - Align Same Width 

 Align the distance of the selected objects in horizontally same distance. 

 

3.1.1.36 Align – Align - Align Same Height 

 Align the distance of the selected objects in vertically same distance. 

 

3.1.1.37 Align – Align - Horizontal Center Align 

  Move the selected objects to the horizontal center. 

 

3.1.1.38 Align – Align - Vertical Center Align 

 Move the selected objects to the vertical center. 

 

3.1.1.39 Align – Rotate - 90° Clockwise Rotate 

 Rotate the selected objects 90 degree clockwise. 

 

3.1.1.40 Align – Rotate - 90° Counterclockwise Rotate 

 Rotate the selected objects 90 degree counterclockwise 

 

3.1.1.41 Align – Rotate - Flip Horizontally 

 Reverse the selected objects right and left. 
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 

 
 

<Figure 14> Image Object – Flip Horizontally 

 

3.1.1.42 Align – Rotate - Flip Vertically 

 Reverse the selected objects upside down. 

 

 

 
 

<Figure 15> Image Object – Flip Vertically 

 

3.1.1.43 Object Fill 

 Set the background color of the selected object.  

Click the left part of the button to apply the selected color. 

If click the right downside arrow, you can see the color table as below.  

 
<Figure 16> Color Popup for Object Fill 

 

You can make background color transparent, click Not Fill. 

If there is no desired color, click Other Color… for the specific color. 
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<Figure 17> Select Other Color 

Click OK to apply it to background color after select the color. 

 

3.1.1.44 Object Border 

 Set the outline color of the selected object. 

Click the left part of the button to apply the selected color. 

If you click the downside arrow of the icon, the color table will be displayed.  

 

<Figure 18> Color Popup for Object Border 

You can make outline color transparent, click Not Fill. 

If there is no desired color, click Other Color… for the specific color. 

 
<Figure 19> Select Other Color 

Click OK to apply it to background color after select the color. 
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Line Style changes the outline type of the object. 

If you move the cursor on the menu, the outline type list will be displayed. Select the 

outline type. 

 

 

Line Width changes the outline thickness of the object. 

If you move the cursor on the menu, the outline thickness list will be displayed. Select 

the outline thickness. 

 
 

3.1.1.45 Set as Color Panel 

 Set as color panel for the selected object. If the installed ribbon is not color ribbon, 

this icon will not be activated. When the object is set as color panel, the blue color is 

applied to the object. 

 

<Figure 20> Set as Color Panel 

 

3.1.1.46 Set as Black Panel 

 Set as black panel for the selected object. Text and barcode are set as black 

panel at default. The background, outline and font will be changed to gray color. For the 

image object, the dithering effect will be applied. If the object is set as black panel, the 

square of outline will be black color. 

 
<Figure 21> Set as Black Panel 
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3.1.1.47 Set as Overlay Panel 

 If you click this icon after select the object, overlay will not be applied to that 

object.  

The Image, text and barcode are not overlaid if this icon is clicked.  

When the object is set as overlay panel, the square of outline will be changed to gray 

color. 

   
<Figure 22> Overlay Panel Editing 

 

3.1.1.48 Set as Rewritable Panel 

 If you click this icon after selecting the object, rewrite function will be applied to 

that object. How to use re-writable panel is same as overlay panel. Re-writable panel will 

appear if the printer is re-writable printer instead of overlay panel. If it is not re-writable 

printer, it is not appeared. The dark area represents that is to be erased on a card. The 

bright area represents that is not to be erased on a card. If the whole parts of panel are 

dark, the front panel of a card will be erased, then re-written. 

 

3.1.1.49 Set as Fluorescent Panel 

 If you click this icon after select the object, fluorescent will be applied to that 

object.  

The Image, text and barcode are fluoresced if this icon is clicked.  

 

 
<Figure 23> Flunrescent Panel Editing 
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3.1.1.50 Display Color Panel 

 You can see all objects which are set as color panel. 

 

3.1.1.51 Display Black Panel 

 You can see all objects which are set as black panel. 

 

3.1.1.52 Display Overlay Panel 

 All overlay panels can be seen. The overlaid area will be displayed darker than 

not overlaid area. 

 

3.1.1.53 Display Rewritable Panel 

 The object display on the screen is chosen by re-writable panel. If select the re-

writable object display that represents part will be erased by dark. This icon will appear 

instead of overlay panel icon if the printer is re-writable printer. 

 

3.1.1.54 Display Fluorescent Panel 

 All fluorescent panels can be seen. The fluoresced area will be displayed more 

blue printed than not fluoresced area. 

 

3.1.1.55 Invert Overlay Panel 

 Basically, overlay is supplied to all surface of card. In case of the text, drawing 

and image object, the contents will not be overlaid. If you want to reverse this, click this 

icon. Refer to the below example. 

   
<Figure 24> Overlay Panel Reverse 

 

3.1.1.56 Invert Fluorescent Panel 

 Basically, re-writable panel is set up to clear the front of card. In case of the text, 
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drawing and image object, the contents will not clear in the card. If you want to clear 

some part and printing, select “Invert re-writable panel” and select the given object in 

area. If select “Invert re-writable”, it will set up to do not clear whole part of card. It will 

clear marked text, drawing and image object. This case will apply equally to Fluorescent 

panel. 

 

3.1.1.57 Front Page 

 This Smart card printer can print the front side and back side. It can be set by the 

printer setup. The icon will be activated when the related side is under designing. 

 

3.1.1.58 Back Page 

 You can design the back side of the card using this icon. It will be activated when 

the printing setup is both-side printing. 

 

3.1.2 Drawing Tap 

 

 

3.1.2.1 Font & Barcode list 

Please refer to Chapter 2.1.1.5. 

 

3.1.2.2 Font Size 

Please refer to Chapter 2.1.1.6 

 

3.1.2.3 Bold 

Please refer to Chapter 2.1.1.7 

 

3.1.2.4 Italic 

Please refer to Chapter 2.1.1.8 

 

3.1.2.5 Underline 

Please refer to Chapter 2.1.1.9 

 

3.1.2.6 Font Color 

Please refer to Chapter 2.1.1.10 
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3.1.2.7 Align Left 

 Text is aligned on the left side. 

 

3.1.2.8 Align Center 

 Text is aligned on the center. 

 

3.1.2.9 Align Right 

 Text is aligned on the right side. 

 

3.1.2.10 Justify 

 Text is aligned on the same distance between the characters. 

 

3.1.2.11 Align Top 

 Text is aligned on the top side. 

 

3.1.2.12 Align Middle 

 Text is aligned on the middle. 

 

3.1.2.13 Align Bottom 

 Text is aligned on the bottom side. 

 

3.1.2.14 Rectangle 

Please refer to Chapter 2.1.1.18 

 

3.1.2.15 Rounded Rectangle 

Please refer to Chapter 2.1.1.19 

 

3.1.2.16 Ellipse 

Please refer to Chapter 2.1.1.20 

 

3.1.2.17 Line 

Please refer to Chapter 2.1.1.21 
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3.1.2.18 Text 

Please refer to Chapter 2.1.1.22 

 

3.1.2.19 Image 

Please refer to Chapter 2.1.1.23 

 

3.1.2.20 1D Barcode 

Please refer to Chapter 2.1.1.24 

 

3.1.2.21 2D Barcode 

Please refer to Chapter 2.1.1.25. 

 

3.1.2.22 Move to Top 

Please refer to Chapter 2.1.1.27 

 

3.1.2.23 Move to Front 

Please refer to Chapter 2.1.1.28 

 

3.1.2.24 Move to Back 

Please refer to Chapter 2.1.1.29 

 

3.1.2.25 Move to Bottom 

Please refer to Chapter 2.1.1.30 

 

3.1.2.26 Left Align 

Please refer to Chapter 2.1.1.31 

 

3.1.2.27 Right Align 

Please refer to Chapter 2.1.1.32 

 

3.1.2.28 Top Align 

Please refer to Chapter 2.1.1.33 

 

3.1.2.29 Bottom Align 

Please refer to Chapter 2.1.1.34 

 

3.1.2.30 Align Same Width 

Please refer to Chapter 2.1.1.35 
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3.1.2.31 Align Same Height 

Please refer to Chapter 2.1.1.36 

 

3.1.2.32 Vertical Center Align 

Please refer to Chapter 2.1.1.38 

 

3.1.2.33 Horizontal Center Align 

Please refer to Chapter 2.1.1.37 

 

3.1.2.34 Same Width Adjustment 

 Change the width of the selected objects same as the standard object. 

 

3.1.2.35 Same Height Adjustment 

 Change the height of the selected objects same as the standard object. 

 

3.1.2.36 Adjust Same Size 

 Change the size of selected objects same as the standard object. 

 

3.1.3 Edit tab 

 

 

3.1.3.1 Undo 

 Reverse the last command. 

 

3.1.3.2 Redo 

 Reverse the action of the “Undo” . 

 

3.1.3.3 Paste 

 Paste the cut or copied object. 
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3.1.3.4 Cut 

 Remove the selection from the design and place it in the clipboard. 

 

3.1.3.5 Copy 

 Copy the selected object in the clipboard. 

 

3.1.3.6 Select all 

 Select all objects in active design. 

 

3.1.3.7 Delete 

 Delete selected object. 

 

3.1.3.8 Object Properties 

 Double-click on the selected object or press Alt+Enter key. A window will appear. 

The contents of the object properties depend on the kind of selected object. 

To apply background color, line color, line type and line thickness to the new object 

created from now on, click the “Set the properties to the new object” . 

 

<Figure 25> Set as basic 

 

In “Position and Size”, “Horizontal” and “Vertical” mean the distance from the left-top to 

the object. “Width” and “Height” mean the width and height of the object. 

In “Ratio”, “Width” and “Height” are 100% at first because this property lets current 

object ratio 100% and can change ratio.  
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Checking “Fix the Ratio of Width and Height” keeps the same ratio. If you change the 

width, Smart Design would change the height automatically with same rate. 

 

<Figure 26> Object Properties - Size 

 

In “Content Tab”, the text or barcode can be changed directly.  

  

<Figure 27> Object Properties - Content 

 

“Text Tab” appears when all selected objects are text ones. In “Inside Space”, you can 

control the size of spaces between the text and edge line of the text objects. 
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<Figure 28> Object Properties - Text 

 

 

 
 

 

You can set the standard of text position in the frame with “Alignment” function. The 

ways of alignment are following. 

Horizontal 

Vertical 

 Top  Middle  Bottom 

Left 
 

 
 

 
 

Center 
 

 
 

 
 

Right 
 

 
 

 
 

Justify 
 

 
 

 
 

<Figure 29> Each case of Align in Text Object 

 

“Fit to frame size” 

 if the text is long enough to over the frame, “ Fit to frame size “ automatically change 

the text size and font to fit to do not cut it off. If the text is shorter to fit the frame, it will 

automatically increase the size of text.  

 

Left Space Top Space 

Right Space Bottom Space



23 

 

 

<Figure 30> Image Object Properties 

 

In “Image Tab”, we can control the value of the image properties. “Enlargement Method” 

in “Ratio” sets the rule of enlargement or decrease image in the frame. 

 

A. Fit same as width 

 

The width of image becomes the same as the width 

of frame maintaining current ratio of width and height 

of the original image. 

 

B. Fit same as height 

 

The height of image becomes the same as the height 

of frame maintaining current ratio of width and height 

of the original image. 



24 

  

C. Fit size same as box size 

 

The width and height of image become the same as 

the width and height of frame. The ratio of the width 

and height of the original image is ignored. 

 

D. User Setting 

 

You can set the ratio of the width and height of the 

image without consideration of the ratio of image and 

frame. 

 

In user setting, “Horizontal Ratio”, “Vertical Ratio” are in active. You can change each 

value. If “Use aspect ratio” is checked, width and height will be changed at the same 

rate.  

 

“Original Width” and “Original Height” represent the size of the original image. They will 

be used for references to change ratio.  

 

You can rotate the image with “Rotate”. The unit for rotation is 90 degrees. 

 

“Horizontal Flip” reverses the image right and left, and “Vertical Flip” turns image upside 

down. 

 

 

 Cancel Vertical Flip Check Vertical Flip 

C
ancel H

orizontal Flip 
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C
heck H

orizontal Flip 

  

<Figure 31> Image Object - Flip 

 

In “Alignment and Offset”, “Horizontal Alignment” and “Vertical Alignment” set the place 

of the image in the frame. 

 

<Figure 32> Image Object - Align 

 

“Image Effect” sets color, contrast and brightness of image 

“Color” sets the color of image. “Auto” keeps the original color of image. “Gray” removes 

colors in the original image, and changes it gray tone. 

 

“Contrast” controls the contrast light and shade. 50% is the same status as original 

image. The rate is available from 0 to 100 percent. You can change the value with scroll 

bar or direct entry. 

 

“Brightness” controls the degree of brightness. 50% is the same status as original image. 

The rate is available from 0 to 100 percent. You can change the value with scroll bar or 

direct entry. 
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<Figure 33> Barcode Object Properties 

 

In “Barcode Tab” you can change the properties of barcode objects.  

“Type” shows the type of the barcode. 

Checking “Show Digit” shows the number at the bottom of the barcode. 

 
<Figure 34> Barcode Object – Show Digit 

 

If “Fit to Frame size” is checked, it will automatically change the barcode size to fit to 

frame size.  

 

3.1.3.9 Contrast Up 

 Contrast up to the selected image object. 

 

3.1.3.10 Sharply Contrast Up 

 Sharply Contrast up to the selected image object. 

 

3.1.3.11 Contrast Down 

 Contrast down to the selected image object. 

 

3.1.3.12 Sharply Contrast Down 

 Sharply Contrast down to the selected image object. 
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3.1.3.13 Brightness Up 

 Brightness up to the selected image object. 

 

3.1.3.14 Sharply Brightness Up 

 Sharply Brightness up to the selected image object. 

 

3.1.3.15 Brightness Down 

 Brightness down to the selected image object. 

 

3.1.3.16 Sharply Brightness Down 

 Sharply Brightness down to the selected image object. 

 

3.1.3.17 Zoom In 

 Zoom in the image. 

 

3.1.3.18 Sharply Zoom In 

 Sharply zoom in the image. 

 

3.1.3.19 Zoom Out 

 Zoom out the image. 

 

3.1.3.20 Sharply Zoom Out 

 Sharply zoom out the image. 

 

3.1.3.21 Move Left 

 Move the image to the left direction. 

 

3.1.3.22 Sharply Move Left 

 Sharply move the image to the left direction. 
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3.1.3.23 Move Right 

 Move the image to the right direction. 

 

3.1.3.24 Sharply Move Right 

 Sharply move the image to the right direction. 

 

3.1.3.25 Move Up 

 Move the image to the upper direction. 

 

3.1.3.26 Sharply Move Up 

 Sharply move the image to the upper direction. 

 

3.1.3.27 Move Down 

 Move the image to the down direction. 

 

3.1.3.28 Sharply Move Down 

 Sharply move the image to the down direction. 

 

3.1.3.29 Set as Color Panel 

Please refer to Chapter 2.1.1.45 

 

3.1.3.30 Set as Black Panel 

Please refer to Chapter 2.1.1.46 

 

3.1.3.31 Set as Overlay Panel 

Please refer to Chapter 2.1.1.47 

 

3.1.3.32 Set as Rewritable Panel 

Please refer to Chapter 2.1.1.48 

 

3.1.3.33 Set as Fluorescent Panel 

Please refer to Chapter 2.1.1.49 
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3.1.3.34 Invert Overlay Panel 

Please refer to Chapter 2.1.1.55 

 

3.1.3.35 Invert Fluorescent Panel 

Please refer to Chapter 2.1.1.56 

 

3.1.4 View Tap 

 

 

3.1.4.1 Change Ruler Display 

 Select whether the display of Ruler or not. 

 

3.1.4.2 Change Grid Display 

 Select whether the display of Grid dot is shown or not. 

 

3.1.4.3 Convert Status Bar 

 Select whether the status bar is shown or not. Status bar shows the information of 

position of mouse cursor and explanation of ribbon bar. 

 

 : Consider all the selected objects as one. Display the starting point in unit of 

millimeter. 

 : Consider all the selected objects as one. Display the width and height in unit of 

millimeter. 

 : Display the current point of mouse cursor in unit of millimeter. 

 

3.1.4.4 Zoom 

 Show the card size you input. 

 

3.1.4.5 Zoom In 

 Zoom in the card layout. 
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3.1.4.6 Zoom Out 

 Zoom out the card layout. 

 

3.1.4.7 100% Zoom 

 Show the original size design. 

 

3.1.4.8 Auto Zoom 

 Fit the size of design panel to the window. As the window size changes, the rate 

of “Zoon In/Out” will be changed automatically. 

 

3.1.4.9 Display Color Panel 

 You can see all objects which are set as color panel. 

 

3.1.4.10 Display Black Panel 

 You can see all objects which are set as black panel. 

 

3.1.4.11 Display Overlay Panel 

 All overlay panels can be seen. The overlaid area will be displayed darker than 

not overlaid area. 

 

3.1.4.12 Display Rewritable Panel 

 The object display on the screen is chosen by re-writable panel. If select the re-

writable object display that represents part will be erased by dark. This icon will appear 

instead of overlay panel icon if the printer is re-writable printer. 

 

3.1.4.13 Display Fluorescent Panel 

 All fluorescent panels can be seen. The fluoresced area will be displayed more 

blue printed than not fluoresced area. 

 

3.1.4.14 Front Page 

 Please refer to Chapter 2.1.1.57 
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3.1.4.15 Back Page 

 Please refer to Chapter 2.1.1.58 

 

3.1.5 Option Tab 

 

 

3.1.5.1 Snap 

 Make cursor move at regular interval.  

 

3.1.5.2 Set background color 

 Select the default color for background. Different colors are available for the front 

and back sides. 

 

3.1.5.3 Show background image 

 Click to print or not background image. 

 

3.1.5.4 Edit background image 

 Edit the background image. To change from background image editing mode to 

normal editing mode, click “Edit Background Image” again, or click outside of 

background image. Only one image for one side is available and it could be printed. 

 

3.1.5.5 Input field setting 

 This function is used for mass issuing like membership cards, student ID cards 

and national ID cards, etc. If you click this button, “Setup Input Field” window is 

displayed. 
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<Figure 35> Setup Input Field 

For further information, please refer to Chapter 4.2. 

 

3.1.5.6 Magnetic field setting 

 Set the field to encode Magnetic Stripe. If you click this button, “Magnetic Setup” 

window is displayed. 

 
<Figure 36> Setup Magnetic Fields 

For further information, please refer to Chapter 3.1. 

 

3.1.5.7 Fit Barcode to Frame 

 If you click this button, it will automatically change the barcode size to fit to frame 

size.  

 

3.1.5.8 Fit Text to Frame 

 If you click this button, it will automatically change the text size to fit to frame size. 
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3.1.5.9 Zoom step 

 Set the change ratio for the image zoom up / down or image movement. 

 
<Figure 37> Setup Image Control Value 

 

3.1.5.10 Language 

 Change language to use. 

 

3.1.6 Help Tab 

 

 

3.1.6.1 About 

 Introduce program version, information etc. 

 
<Figure 38> About Smart Design 

 

3.1.6.2 Help 

 This Smart Design user manual will be open. 

 

 



34 

3.1.2 File Tab 

 
 

3.1.7.1 New File 

 Start a new design. 

 

3.1.7.2 Open 

 Open or find a file. 

 

3.1.7.3 Save 

 Save the active file. 

 

3.1.7.4 Save As 

 Save the active file with new name. 

 

3.1.7.5 Print Setup 

 Set up the properties for printing such as printing direction, ribbon option, etc. 
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<Figure 39> Print Setting 

You can change the printing direction to horizontal or vertical. 

 
<Figure 40> Printing Layout Change 

  
<Figure 41> Printing Direction Setting 

Caution: It may place the active design out of the printing area if you change direction. 

Click “Properties” to change the printer driver option. 

 

Click “Advanced” for detail setting of printer. We don’t recommend to use this menu 

because it may cause some printing errors. “Horizontal” and “Vertical” mean printing 

direction. They carry out the same function of the “Direction” in “Printer Option” 

commented just above. 
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<Figure 42> Paper/Ribbon/Quality Setting 

 

“Paper Tray” is the option for blank cards. “Paper” sets up the way to supply blank cards. 

Default value is “Auto.” Smart Card Printer supports only CR-80 size cards. 

 

“Ribbon” sets up the kind of ribbon film in printer. 

YMC.K.O - Ribbons with YMC. K. and O films will be printed on 

the front side only. 

YMC.K.O.K - Ribbons with YMC, K, and O films will be printed on 

the front side while K will be printed on the back side. 

Half YMC.K.O - Ribbons with half panel YMC, and full panel K,O films 

will be printed on the front side only. 

K.O  - Ribbons with resin black K, and O films will 

be printed on the front side only. 

K(mono) - Ribbons with black K films will be printed on the front 

side only. 

B.O  - Ribbons with dye black B, and O films will be 

printed on the front side only. 

B  - Ribbons with dye black B films will be printed 

on the front side only. 

B.YMC.K.O -  The Ribbon consists of adjustable dye Black (B), 

Color (YMC), resin Black (K), Overlay (O) film. It is for 

one side color printer ribbon.  

YMC.K.F.O - The Ribbon consists of Color (YMC), Black (K), 

Fluorescent (F), and Overlay (O) films. It is for one side 

color printer ribbon 

Rewritable - The printer is rewritable printer. It does not use ribbon. 

If you set up this case, It will infect to design front and back, color black, overlay and 
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fluorescent panel set up. 

 

“Resin” sets up the way to extract black from the data transmitted to printer. 

Black Objects - Black Circle, lines, polygons and black shape can be 

extracted and they will be printed by black ribbon 

Black Texts - Black text can be extracted and they will be printed by 

black ribbon 

Black Dots - Black dot can be extracted and they will be printed by 

black ribbon 

Not Use - No black extraction. 

 

“Split” option decides to separate part of panel to the next page.  

Normal - No Split. 

Split for Backside - You can set the both sides (Front:YMCO, Back:K) to 

save color ribbon(YMCKO, HYMCKO, BYMCKO). It is 

only activated while printing both sides option is set. 

 

“Mode” option set printing mode. 

Standard. - Default print mode. Print all area. 

Partial - Partial print mode. It is printed partially for the print 

area only. Printing speed can 

be faster than standard mode. 

 

“Speed” option set printing speed and quality. 

Standard - Default print mode and best quality setting option of 

printing. 

High - Fast print mode. This option can be used with only K 

and KO ribbon. Printing quality might be lower than 

Standard. 

 

“Color” option set up to output color.  

Color. - It can print color and black & white data. (“Color” option 

is available only with color ribbon.). 

Black & White - It can change color data to black & white data. Dither 

option set up color data to Black & White. 

“Dither” option set up dither method. 

There are 3 possible selections, Threshold, Random, and Diffusion Dither. It is 

performed with K and KO ribbon only. (Please select “Diffusion Dither” for high quality.) 
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<Figure 43> Printing Side Setting 

 

“Side” option set up to print backside.  

Front - Print only front side. If the ribbon installed is YMCKOK, 

the final K is skipped. 

Both(Front + Back) - Print both sides. If the ribbon installed is 

YMCKO, both sides will be printed with color. If the 

ribbon installed is YMCKOK, front side will be printed 

with color and back side will be printed with black (K 

panel). 

 

“Media” shows the kinds of card used in printing. The card type what you have chosen 

will fix the printing area. 

Standard - Normal white card. Print the whole card area. 

Smart Card - Smart card. Print except smart chip area. 

Smart Card[right only] - Smart card. Print the right area from the 

smart chip. 

ISO MS(Magnetic Stripe) - Magnetic stripe card. Print except ISO 

standard magnetic stripe area. 

JIS MS(Magnetic Stripe) - Magnetic stripe card. Print except JIS 

standard magnetic stripe area. 

Smart Card + ISO MS - Complex card of smart and magnetic stripe 

card. Print except smart chip and ISO standard 

magnetic stripe area. 

Smart Card + JIS MS - Complex card of smart and JIS magnetic 

stripe card. Print except smart chip and JIS standard 

magnetic stripe area. 

No Overlay - It will be printed except overlay.  
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User Defined Card - User defines the printing area. 

 

“Edge” has following options. 

Not Use - Don’t print the edge of card. Printing area becomes 

slightly smaller. 

Use - Print to the edge of card. 

 

 
<Figure 44> Laminating Side Setting 

If the printer with laminator is connected, “Laminator” tab is displayed. 

 

3.1.7.6 Print 

 Print the active design file or save Preview of design file to BMP file. 

Click Print in File tab, the screen is changed as below.  

 
<Figure 45> Print Preview 

 

Print the active design. Click Print button, “Print” window is displayed. 
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<Figure 46> Print – Select Printer 

If you make some changes with “Properties”, they are affected only this time. If print 

direction is changed in “Properties”, Smart Design will change the design screen at the 

same time to prevent print error. 

 

If you click Save Preview button, the preview image on the right section is saved as 

BMP file. 

 

3.1.7.7 Recent file 

Show the list of design files latest worked. As you click one of them, it would be opened. 

 
<Figure 47> Recent File 

 

3.1.7.8 Exit 

 Exit Smart Design. 
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3.2 Properties Grid 
 

Properties Grid is “Object Properties” window on the right side of main window. You can see and 

modify the properties of selected object.  

   
<Figure 48> Properties Grid 

 

3.2.1 Base Category 

 

<Figure 49> Properties Grid – Base Category 

It shows the information of position and color of object in Base Category. If several objects are 

selected and properties are different, the value is not displayed. If the value is modified in 

Properties Grid, selected objects are applied. 

 

3.2.1.1 Page 

It shows the page where selected object is. Read only. 

 

3.2.1.2 Panel 

It shows the panel which selected object is printed on. 
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3.2.1.3 Left 

It means the distance from the left side of background to the object.  

 

3.2.1.4 Top 

It means the distance from the top side of background to the object. 

 

3.2.1.5 Width 

It means the width of the object. 

 

3.2.1.6 Height 

It means the Height of the object. 

 

3.2.1.7 Rotate 

It shows the value of angle of the object. Unit is 90 degrees. You can select the value 

among 0, 90, 180, 270 degrees. 

 

3.2.1.8 Border – Style 

It shows the line style selected. 

 

3.2.1.9 Border – Width 

It shows the line width selected. If Style is “no border”, you can’t change the value. 

 

3.2.1.10 Border – Color 

It shows the line color selected. If Style is “no border”, you can’t change the value. 

 

3.2.2 Extended Category – Rounded Rectangle 

 
<Figure 50> Properties Grid – Extended Category – Round Rectangle Object 

If the selected object is rounded rectangle, it shows the properties of rounded rectangle. 

 

3.2.2.1 Corner Round 

It shows the value of edge in Rounded Rectangle. Unit is % and range is 1~100. If the 

value if 0, object shape is rectangle. If the value is 100, the short part of width or height 

is rounded without line. 
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3.2.3 Extended Category – Image 

 
<Figure 51> Properties Grid – Extended Category – Image Object 

If the selected object is image, it shows the properties of image. 

 

3.2.3.1 Original Width 

It shows the width size of the original image. Read only. 

 

3.2.3.2 Original Height 

It shows the height size of the original image. Read only. 

 

3.2.3.3 Auto Effect 

It shows whether Auto Effect is applied or not. Auto Effect is the function to adjust the 

brightness and contrast in a picture automatically. If the value is true, brightness and 

contrast is adjusted properly. Default is false. 

 

3.2.3.4 Contrast 

It shows the value of Contrast. Range is -100 ~ 100. Default is 0. If the value is 

increased, image color changes primary color. If the value is decreased, image color 

changes gray color. If Auto Effect is True, this value is not applied. If you change this 

value when Auto Effect is True, the value is applied and Auto Effect changes False. 

 

3.2.3.5 Brightness 

It shows the value of Brightness. Range is -255 ~ 255. Default is 0. If the value is 

increased, image color changes white. If the value is decreased, image color changes 

black. If Auto Effect is True, this value is not applied. If you change this value when Auto 

Effect is True, the value is applied and Auto Effect changes False. 

 

3.2.3.6 Color Mode 

It shows the mode of color. You can select Color and Grayscale. Default is Color. If Auto 

Effect is True, this value is not applied. If you change this value when Auto Effect is True, 

the value is applied and Auto Effect changes False. 
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3.2.3.7 Auto Portrait 

Auto Portrait is the function to find the face in the Image automatically.  

If the value is true, the image is focused on the face and adjusted the size and position 

properly. Default is false. 

 

3.2.3.8 Scaling 

It shows the mode of zoom. If you set Auto Portrait, this value is changed to “User Set”. 

Default is “Fit to Width of Frame”. Please refer to Chapter 2.1.4.8 A. 

 

3.2.3.9 Width Zoom 

It shows the ratio of width of the image. 

 

3.2.3.10 Height Zoom 

It shows the ratio of height of the image. 

 

3.2.3.11 Horz. Align 

It shows the mode of Horizontal alignment. If this value is “Left”, image shows from the 

left side in the frame. If this value is “Right”, image shows from the right side in the 

frame. If this value is “Center”, image shows on the center in the frame. The value of 

“Inside Left Offset” depends on this value. Default is Center.  

 

3.2.3.12 Vert. Align 

It shows the mode of Vertical alignment. If this value is “Top”, image shows from the top 

side in the frame. If this value is “Bottom”, image shows from the bottom in the frame. If 

this value is “Middle”, image shows on the middle in the frame. The value of “Inside Top 

Offset” depends on this value. Default is Middle. 

 

3.2.3.13 Inside Left Offset 

It means the left offset value of start position of image in the frame. 

 

3.2.3.14 Inside Top Offset 

It means the top offset value of start position of image in the frame. 

 

3.2.3.15 Corner Round 

It shows the value of edge in image. Unit is % and range is 1~100. If the value if 0, 

object shape is rectangle. If the value is 100, the short part of width or height is rounded 

without line. 
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3.2.3.16 Field 

It shows the field connected to image. If field is already connected to other text or 

barcode when the field is changed, you can’t connect that field. 

 

3.2.4 Extended Category – Text 

 
<Figure 52> Properties Grid – Extended Category – Text Object 

If the selected object is text, it shows the properties of text. 

. 

3.2.4.1 Inner Left Space 

It shows the value of inner left space of text in the frame. 

For further information, please refer to 2.1.4.8 

 

3.2.4.2 Inner Top Space 

It shows the value of inner top space of text in the frame. 

For further information, please refer to 2.1.4.8 

 

3.2.4.3 Inner Right Space 

It shows the value of inner right space of text in the frame. 

For further information, please refer to 2.1.4.8 

 

3.2.4.4 Inner Bottom Space 

It shows the value of inner bottom space of text in the frame. 

For further information, please refer to 2.1.4.8 

 

3.2.4.5 Horz. Align 

It shows the mode of Horizontal alignment. If this value is “Left”, text shows from the left 

side in the frame. If this value is “Right”, text shows from the right side in the frame. If 

this value is “Center”, text shows on the center in the frame. If this value is “Justify”, text 

shows on the same distance between the characters. Default is Center. 
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3.2.4.6 Vert. Align 

It shows the mode of Vertical alignment. If this value is “Top”, text shows from the top 

side in the frame. If this value is “Bottom”, text shows from the bottom in the frame. If 

this value is “Middle”, text shows on the middle in the frame. Default is Middle. 

 

3.2.4.7 Auto Size 

It shows whether Auto Size is applied or not. If this value is True, text size will 

automatically change the size to fit to frame size. 

 

3.2.4.8 Font 

It shows the font type, style and size of text.  

 

3.2.4.9 Color 

It shows the font color of text.  

 

3.2.4.10 Text 

It shows the content of text. 

 

3.2.4.11 Field 

It shows the field connected to text. If field is already connected to other image when the 

field is changed, you can’t connect that field. 

 

3.2.5 Extended Category – Barcode 

 
<Figure 53> Properties Grid – Extended Category – Barcode Object 

If the selected object is barcode, it shows the properties of barcode. 

 

3.2.5.1 Type 

It shows the type of barcode. If the barcode is 1D type, you can’t change 2D barcode 

type. If the barcode is 2D type, you can’t change 1D barcode type. 
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3.2.5.2 Size 

It shows the size of barcode. 

 

3.2.5.3 Color 

It shows the color of barcode. 

 

3.2.5.4 Parameter 1 

It shows the value of “option 1” if the barcode type is 2D. It is inactivated if the barcode 

type is 1D. This means of value depends on 2D barcode type.  

 

3.2.5.5 Parameter 2 

It shows the value of “option 2” if the barcode type is 2D. It is inactivated if the barcode 

type is 1D. This means of value depends on 2D barcode type. 

 

3.2.5.6 Show Digit 

It shows whether text of barcode is shown or not. It is inactivated if the barcode type is 

2D. If the value is changed to “Show”, text is displayed on the bottom of barcode. 

 

3.2.5.7 Auto Size 

It shows whether Auto Size is applied or not. If this value is True, barcode size will 

automatically change the size to fit to frame size. 

 

3.2.5.8 Start Code 

It shows the “Start Code” if the barcode type is Codabar. It is inactivated if the barcode 

type is not Codabar. 

 

3.2.5.9 Stop Code 

It shows the “Stop Code” if the barcode type is Codabar. It is inactivated if the barcode 

type is not Codabar. 

 

3.2.5.10 Data 

It shows the data of barcode. 

 

3.2.5.11 Zip Code 

It shows the zip code if the barcode type is Maxicode. Max size is 15 characters. 

 

3.2.5.12 Field 

It shows the field connected to barcode. If field is already connected to other image 

when the field is changed, you can’t connect that field. 
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3.3 Drawing Area and Etc. 

 
<Figure 54> Drawing Area 

 

3.3.1 Drawing Area 

 

3.3.1.1 Selection Mode 

 

1. Object selection 

1) Direct selection  

Move the cursor to the object and click when cursor is changed to .  
 

2) All selection 

Drag the cursor with pressing the left button of the mouse from one point to the 

other point. All the objects in this area will be selected. 

 

3)  Using “Mouse and Shift key” 

Click any object what you want to select with pressing Shift key  

 

※ Standard object 

If you select more than one object, the colored dot outline as below will be the 

standard object for the movement, size adjustment and etc. 
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<Figure 55> Standard Object 

 

2. Movement of selected object 

1) Using “Mouse” 

Put cursor on the object which you want to move and press left mouse button 

and drag. 

2) Using “ Mouse and arrow key” 

Select object and press the arrow key  

 

 
<Figure 56> Move Objects 

 

3. Size adjustment of the selected object 

1) To change the object size, select the related object.  When put the cursor 

near the edge of the object, the cursor changes to                .   Press 

the left mouse button and drag the mouse. You can adjust the object size.  

2)  If you adjust with “Mouse and Shift key”, the width and length will be changed 

at the same ratio.   

3)  With “Ctrl” key, object is changed focusing to the center. 

 
<Figure 57> Resize Objects 
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4. Copy the selected object using ”Mouse and Keyboard” 

To copy the object, drag it with pressing “Ctrl” key. 

 

5. To make round shape 

In case the selected objects are rectangle, rounded rectangle or image object, 

there will be displayed the yellow diamond mark. This is control point. Put cursor 

on diamond, click left mouse button and move it left and right side. The round 

shape will be changed. 

 

<Figure 58> Change Corner Rounding 

 

3.3.1.2 Drawing Mode 

When you select Drawing tool, Mode is changed. 

Cursor is changed to  .   . 

 

3.3.2 Ruler 

It shows the position of selected object and cursor. 

You can show and hide “Change Ruler Display” button in View tab. 

 

3.3.3 Status bar 

It shows the explanation of ribbon bar in the position of cursor and coordinates of cursor. 

 

 : Consider all the selected objects as one. Display the starting point in unit of 

millimeter. 

 : Consider all the selected objects as one. Display the width and height in unit of 

millimeter. 

 : Display the current point of mouse cursor in unit of millimeter. 
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4 Professional Function 
4.1 Encode in Magnetic stripe 

 

Enter information in magnetic track. 

 
<Figure 59> Magnetic stripe Setting 

 

Select one option among “Normal”, “Reverse”, “Bit mode”. 

In “Normal” mode, the data is recorded in magnetic stripe along with the card movement direction. It’s 

usual recording method. In “Reverse” mode, Magnetic stripe is on the front of card so that the data is 

recorded in reverse. In “Bit Mode”, magnetic encoding data would be recorded with bit format. To 

encode in Bit mode, the user can write specific data and it does not follow the standard of magnetic 

writing. Therefore, when the card encoded in Bit mode is read by reader, errors can be occurred. 

 

 
<Figure 60> Magnetic Setting - Normal 

Select “Normal” in “MS1” track to use magnetic track No.1. 

 

<Figure 61> Input Area of Magnetic Track 

The white cells are the spaces for entering data. The blue bar at the bottom is scroll bar. 

Black cell in the entering space is the active one. With keyboard, characters are entered in the cell. To 

link between magnetic track and field, select areas to enter value of the field by mouse drag and then 
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click right button for pop-up menu. 

 
<Figure 62> Magnetic Setting – Cell Group 

 

There is the list of current fields in the sub-menu of “Input Field”. The selected cells are defined the 

area of selected field as you select one of the fields. 

 
<Figure 63> Magnetic Setting - Input 

 

To cancel the link, click right button for pop up menu, and click “Cancel Setup” or select cell and click 

“Delete” key. 

 

To encode in Bit mode, set the track as Bit mode. If the track is set to Bit mode, the track information 

of previous normal status is back-up and input field is changed to Bit mode field. In Bit mode, the user 

can input data as Hex-Decimal String and the field can be connected to “Input Field” and the data in 

Input field should be written as Hex-Decimal string, as well. 
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<Figure 64> Magnetic Setting – Cell Group 

 

 

This can be also applied to the other magnetic tracks.  
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4.2 Continuous issuing (Mass issuing) 
4.2.1 Usage  

This function is used for mass issuing like membership cards, student ID cards and national ID 

cards, etc.  

 Design basic cards form with Smart Design →  Change name, picture, number, etc. → 

 Check each cards information is correct →  Start to mass printing 

* You can import from or export to the Microsoft Excel, Microsoft Access and ODBC by using 

Smart DB. Please refer to the Smart DB User Manual. 

 

4.2.2 Field creation, add, delete 
At first, design the card what you want to print with Smart Design. 

 

<Figure 65> Document for Mass Issuing 

Click : Ribbon bar  Option tab  “Input field Setting” 

Input field management window appears. 

 
<Figure 66> Input Field Setting 
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To set input field name, open input field at first and enter the field name. Field name is 

capital letters always. After creating field name, double click the next column. In default 

Value column, enter subject, then click “Close” button. You have set basic field name. 

 

After field is created, field and object should be linked. All objects such as text, image, 

barcode and magnetic track are available to link with field. Select a field in the field list and 

an object on the screen. Click “Connect field” to make connection between the field and the 

object. Then, the default value of the field is applied to the object. 

 

Fields linked with text object and barcode object cannot be linked to image object. Because 

there should be image file name in the image objects. For the same reason, fields linked 

with image objects cannot be linked with text or barcode objects. 

 

When image object is linked to field, “File Search” button is created in the default value 

column. Double click to enter the whole file path or click “Search” button to select image file. 

 

Click “Disconnect” to disconnect link between field and objects. 

 

To delete or edit field, select the field and click right button. Two options will be shown.  

 
<Figure 67> Delete or Revise Input Field 

 

Click “Delete Field” to remove all link information about the selected field. 

Click “Edit Field” to change the value of the field. You can make activate a cell just double 

click to the cell what you want to change. 

 

Click “Print” to print directly from this menu. 


